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                                                   Purpose statement 

 

This module describes the skills and knowledge required to describe the logo, identify the logotype and to 

sketch the logo to select logo motifs and logo color definition. In addition to that, the learner will also be 

able to illustrate and produce a banner layout and design blueprint, organize and select image assets and 

typefaces, treat photos, select colors  and combine creative software export the designed banner to meet 

specified requirements using one of existing software design such as Photoshop and GIMP. 
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Learning Unit 1 – Prepare for logo and identities design pare for printing document 

 

LO 1.1 – Describe logos 
 

 Content/topic 1:  Describing logos 
 

A logo is a graphic mark, emblem, symbol or stylized name used to identify a company, organization, 

product, or brand. It may take the form of an abstract or figurative design, or it may present as a stylized 

version of the company's name if it has sufficient brand recognition (KENTON, 2019). 

 Logo types 

o Word mark (Text) 

Office Max, Home Depot, and Walmart all represent the most commonly used type of logo — the word mark. 

Typically, this type of logo relies on text, typeface, and unique typographic treatments to express the brand’s 

identity. Because there are no graphic elements to convey messaging, the text is often exactly literal, stating 

the name of the company and sometimes even what it does (Deluxe, 2020). 

Word marks work best for companies whose names describe what they do, or for those with a distinctive 

name, even if it’s not yet a household word. 

 

 

 

 

 

 

                               Figure 1: Word mark (Text) 

o Letter mark (Initials) 
 

Think of a letter mark logo as a monogram for your business. Like a word mark, a letter mark is entirely text, 

but rather than the entire name of a business the logo relies on initials to represent the brand. Letter marks 

can be a simple monogram or an anagram. CNN is an example of a monogram letter mark logo — it uses the 

initial letters of the company’s full name, Cable News Network, to create the logo. FedEx represents an 

anagram letter mark logo, drawing on the first few letters of each word of the corporate name — Federal 

Express 

 

 

 
Figure 2: Letter mark (Initials) 
 

o Brand mark (Symbol or Icon) 
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Departing from the use of text alone, a brand mark symbol uses a strong graphic, which is often abstract, to 

highlight an aspect of the product or service the business sells. The symbol represents the company by 

association and relies on the design’s ability to evoke emotion in a viewer. For example, the Nike swoosh 

implies motion, the perfect representation for the company’s line of athletic shoes and athletic wear. 

A brand mark logo works well if you need an emblem for your product, or if your name is too long, generic 

or lacking in personality. 

 

 

 

 

 

 

Figure 3: Brand mark (Symbol or Icon) 

 
o Iconic logo design 

A marriage of a brand mark symbol with a work mark, iconic logos are also referred to as combination logos. 

Elements may be used together or separately, tied closely or loosely. This type of logo can be very effective 

in communicating both what a company does and what it stands for (its corporate personality). MasterCard 

Worldwide, NBC’s peacock logo, and Dunkin’ Donuts are examples of iconic logotypes. 

 

 

 

 

 

 

 

 

Figure 4: Iconic logo design 

 

 

 

 

 

 

 

 

 

 

 Combination Mark (Text and Symbol) 
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A combination mark is simply logotype and logo mark combined into one logo. Text and image or icons are 

combined to enhance the branding message and helps clarify what a business is all about. There are however 

integrated and standalone combination marks. 

 

 

 

 

                       Figure 5: Combination Mark logo 

 Emblem (Text Inside Symbol) 

Also known as a Badge, the badge logo is a combination mark that is contained in an enclosed shape. 

Often the badge acts as a container for the brand name and symbol (or mascot), but in some cases 

the overall badge shape–Harley-Davidson, for example—takes on its own life as a visual identifier for 

the brand. 

 

 

 

 

 

 

 

  Figure 6: Emblem logo 

 Logo terms 

 Brand 

 
A logo is a graphic mark, emblem, symbol or stylized name used to identify a company, 

organization, product, or brand. It may take the form of an abstract or figurative 

design, or it may present as a stylized version of the company's name if it has sufficient 

brand recognition. 

 Identity 

 

The visual aspects that form part of the overall brand 

A company logo is a symbol of your company's identity. It creates a first impression of 

your company and expresses your company's value all in one. People have learned to 

associate a brand's logo with its values and character. 

 

 

 Icon 
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In the instance of mobile apps, most organizations choose the emblem part of their 

logo, or often a defining feature of their brand or service they provide, to be the icon. 

This way they remain instantly recognizable (Brandt, 2016). 

 Content/topic 2: Logo Design considerations 
 

 Versatile 
A good logo can be used in a variety of sizes and colours. Your logo should have the versatility to appear on 

collateral for a pen to a plane. This dramatic physical scale in usage demonstrates how an identity needs to 

work across a wide scope of collateral. 

 

 Simplicity 

Your logo needs to be easily identifiable at a glance. Allow for changes of size and colour. Good logos deliver 

something unexpected and are unique without being complicated. 

 Meaning 

One of the most important things to make a logo design success is its meaning or message. Barely 
seeing a logo on a product or advertisement is not enough to make it memorable. More than being 
a remarkable visual, it should be symbolically conveying some deeper meaning. First, write your 
brand strategy statement on paper. Then, see if the logo is conveying it or not. Redesign the logo if 
the purpose is lacking. 
The logo should be able to show its intent behind the design. It must be a concise visual 
representation of your brand. Even your prospective customers should be able to easily understand 
and describe the purpose. 
 

 Memorable 

Your logo needs to be easily identifiable at a glance. Allow for changes of size and colour. Good logos deliver 

something unexpected and are unique without being complicated. 

 
 

 Timeless 
 

An effective logo should be timeless and should avoid trends. It should last the test of time. How will your 

logo look in 10 years’ time? 
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The London underground logo is timeless. The identity is over 100 years old and has worldwide iconic status, 

its application of use is still going strong. 

 
 Appropriate 

 
A professional logo should be fit for purpose. The logo should be appropriate for the intended audience. For 

example a logo for a toyshop could be colourful and playful in its execution however, the same wouldn’t 

apply to a law firm. 

 

 Uniqueness 
Uniqueness implies that a logo should be designed on a new concept that has not been used before by 

anyone. Clearly, the concept is attractive to the viewers as they seen the design idea for the first time and 

no one else is going to copy it in the future also due to copyright issues. 

  Consistency 

Consistency develops routines and builds momentum. It forms habits that become almost second 

nature. ... Leadership guru John Maxwell said: "Small disciplines repeated with consistency every day 

lead to great achievements gained slowly over time." Consistency is especially important in business. 

 

 Content/topic 3: Logo design process 
 
Motivation: We’re not here to judge—if it’s stupid but it works, then it’s not stupid. But we are here to 

outline a general logo design process that you can use as a starting point. 

Step 1. Evaluate the brand 

Your first step in the logo design process is to understand what the brand embodies and what the business’s 

goals are. This is known as the Client Discovery phase. There’s no one-size-fits-all for logo design—a logo is 

only as good as its representation of a business, so it won’t be effective unless you first know what kind of 

impression the brand is aiming for. 

 

Here are just a few general questions you can start with to kick off your client research: 

 Why are you getting a logo design? What problem are you trying to solve? 
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 If your brand were a person, what adjectives would you use to describe it? (Clever, prudent, etc.) 

 What is your brand voice? (Eloquent & formal, jokey with slang, etc.) 

 Which beliefs and values are important to your brand? 

 What is your unique value proposition? What does your company offer that your competitors don’t? 

 How do you want your customers to describe your brand to their friends? 

Step 2. Research the industry 
No brand exists in a vacuum. Every company has to contend with the standards of their industry, even if they 

are doing everything to stand out. So the next step in the logo design process is to research what kind of 

logos competitors and industry leaders have. This is referred to as the Industry Discovery phase, and it can 

mean the difference between a logo that is generic and one that is too far out of left field. 

 

 

 

Step 3. Make a list of where the logo will be used 
Just like the brand strategy, the physical or digital space the logo will occupy should also inform your design 

choices. Research where the logo will be used—this is known as the Application Discovery phase. Although 

you may not yet have a complete list, the earlier you can predict how your logo will be used, the better for 

logo development. Where you need your logo might determine the colour model, the shape or even design 

software used. 

For example, if you want your logo on large billboards, you can design more detailed, larger-scale logos. If 

it’s going to be situated in the corner of a mobile app, you should opt for simplicity and smaller scales. If 

social media will play a heavy role, the logo should sit comfortably in both circular and square avatars and 

be adaptable to larger cover images. If you want to stand out in video or digital platforms, you can even have 

an eye-catching animated logo. More often than not, a designer will want to plan for all of these scenarios. 

These are some common use cases for logo design: 

https://99designs.com/blog/creative-inspiration/animated-logos/
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Website icons 

 Signs and banners 
 Product packaging 
 Advertisements 
 Social media profiles and banners 
 Business cards 
 Company letterheads (invoices, internal documents) 
 Email marketing campaigns 
 Marketing swag (pens, shirts, mugs, etc.) 

 

Step 4. Sketch a variety of logo concepts 
 
If you already have some logo ideas, you might be tempted to jump ahead into logo design software. But 

before you start zeroing in on your final design, take some time to sketch plenty of ideas. Sketching is cheap, 

easy and fast, but most importantly, it’s an effective brainstorming tool. 

Step 5. Create digital drafts in vector software 
 
By now, you should have a messy smorgasbord of logo sketches as well as a better sense of what you want 

the final logo to look like. Of those sketches, take around 3 of your best ones and recreate them in your 

design software. This is where your final logo really starts taking shape. 

Step 6. Refine your logo design with feedback 
 

Here’s something you don’t need to be a designer to appreciate: everyone’s a critic! No matter how perfect 

you think your logo design is, chances are someone, somewhere, is going to request changes. 

That’s not always a bad thing. When you work on the same image for hours or days (or weeks, or months), 

you tend to mistake the forest for the trees. A fresh set of eyes on the final product can reveal some room 

for improvement you hadn’t noticed before. 

Step 7. Prepare and deliver the final logo files 
 

With your logo finalized, it’s time to deliver your final files! You should determine what design files your 

client needs at the start of the process (in case they have any special requirements). But in general, it is best 

to include: 

 Layered source vector files, such as AI 

 Layered EPS/PDF files (for clients using different vector programs) 

 High resolution raster files for web, including PNGs with transparent backgrounds 

LO 1.2 – Specify logo design requirements 
 

 Content/topic 1: Establish Creative briefs  

https://99designs.com/blog/logo-branding/logo-design-software/
https://99designs.com/blog/tips/image-file-types/
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 Brand identity  

 A brand identity as “the outward expression of a brand, including its trademark, name, 

communications, and visual appearance.” To us, a brand identity is the sum total of how your 

brand looks, feels, and speaks to people. (Sometimes that even includes how i t sounds, tastes, 

feels, and even smells.)  Ultimately, a brand identity is a way to communicate with the world, 

differentiate yourself from your competition, and create a brand experience that encourages 

people to engage with you.  

Some brands elevate brand identity to an art (think Apple, LEGO, or Levi’s). Some brands make it 

their entry into the playing field (think War by Parker or Casper). Unfortunately, some (okay, 

many) brands struggle because they don’t know who they are or don’t know how to communi cate 

it effectively. (Not sure if you’re current brand identity works for you? Here are  9 signs it doesn’t.) 

Regardless of where you fall on that spectrum, one thing is sure. If you want to be a competitive 

and successful company, crafting a strong brand identity is mandatory. When you can successfully 

communicate who you are, you can better communicate with people and form the strong 

relationships you need for long-term success.  

What Does a Brand Identity Include?  

A logo and a color palette alone do not make a brand identity. When designing your identity, you 

need to create a comprehensive visual language that can be applied to everything from your 

website to your packaging. Depending on your brand (and the type of content you plan to create), 

your needs may be more expansive, but a basic brand identity includes:  

 Logo 

 Colors 

 Typography 

 Design System 

 Photography 

 Illustration 

 Iconography 

 Data visualization 

 Interactive elements 

 Video and motion 
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 Web design 

 Remember: Your brand identity should translate across mediums, so include everything 

you need to make sure it does.  

Complete Your Brand Strategy 

Your brand strategy is a detailed plan that outlines exactly what you’re trying to achieve and how 

you’re going to achieve it. It is comprised of you’re: 

 Brand Heart (purpose, vision, mission, values) 

 Brand Messaging (brand voice, personality, tagline, value prop, brand messaging pillars) 

 Brand Identity (logo, color, typography, etc.) 

Your brand identity is really a tool to help you communicate your brand visually, thus supporting 

your brand strategy. As such, before you dive into your brand identity, it’s important to have a 

fully fleshed out strategy.  

 Background information  

As the name suggests, background information means all information that a reader requires to increase his 

awareness of the topic an essay is going to explain. Background information is placed shortly after 

the hook or attention grabber. Both are intertwined, as the hook cannot be separated from the background 

information. 

Both are connected with a transition word. Usually, in a five-paragraph essay, background information 

comprises three to five sentences. However, in a longer essay, it could be more than 10 sentences or even a 

full paragraph. Generally it needs to be as long as necessary to inform readers on the topic. There are as 

many types of background information as there are types of essay, some of which are as follows: 

Types of Background Information 

1. Description Type 

Description type of background information often describes the topic through sensory description 

involving all five senses: sense of touch, sense of smell, sense of sight, sense of hearing, and sense of 

taste. Words are used to make the reader experience any of these or all. 
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2. Process Type 

In a process type of background information, a writer provides an introduction to the topic, telling 

readers what process will be used to achieve a goal, or complete a task. 

3. Definition Type  

In a definition type of background information, readers become aware of the definition of the topic, 

as well as how it differs from other such similar terms and words. 

4. Classification / Division Type 

In a classification / division type of background information, readers are informed about the topic, 

how it is classified and divided, and what further derivations it could have. These are further 

explained in body paragraphs. 

5. Argumentative Type 

In an argumentative type of background information, readers are informed about the topic, the 

arguments being made in support of the question about the topic, and opposing arguments. 

6. Persuasive Type 

a persuasive type of background information attempts to persuade the reader, by giving information 

about a question. 

 New project or redesign  

 Below are the 7 basic steps to logo development, complete with examples that show the process in action. 

 Evaluate the brand. ... 

 Make a list of where the logo will be used. ... 

 Sketch a variety of logo concepts. ... 

 Create digital drafts in vector software. ... 

 Refine your logo design with feedback. ... 

 Prepare and deliver the final logo files. 

 

 Output expectations 

Brand strategies provide the blueprint upon which incredible logos can be built. Usually, a strategy will 

involve collaboration between clients, designers, and other essential partners in the company. Strategies are 

crucial because they provide direction. Without some proper up-front thinking and a solid brief, you’re 

always going to be on the back foot. 

Whether your logo design ideas begin with a simple one-page design brief, or a highly sophisticated (and 

expensive) brand strategy, you’re going to need a clear purpose. Without a strong framework on which to 

build your brand, you’ll find your logo designs simply don’t stand up to the test of time. In fact, without some 
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agreed criteria to judge your decisions against, everything might come down to someone simply pointing at 

a design at random and saying… “I’m not sure why, but I like that one.” 

If you can get your hands on a brand strategy report before you start considering how to design a logo, that’s 

a good start. With any luck, this will provide an insight into the type of organization you’re working with, its 

competition, positioning, mission and values. If such a document doesn’t exist, you’ll have to do some 

legwork yourself. Talk to your client (and preferably get more than one person’s perspective) about who 

they are, what they stand for, how they see themselves and how they’d like their customers to see them. 

With or without a brand strategy document, it’s essential to start with a clear creative brief. That means 

going beyond a couple of notes jotted down during your first phone call or meeting. Figure out what makes 

the business different, and how you’re going to position it in the marketplace. Write up your thoughts and 

get your client to sign off on your plan so that everyone knows where they are and what to expect. 

Remember, the goal is to end us with a high-quality logo design. 

 Design preferences  

Brand logos can provide affective reactions before any promotional activity is carried out. This is 

particularly relevant for start-ups that might not have the budget for branding activities. Extant research 

is predominantly based on theoretical models. By contrast, we adopted a customer-based approach with 

a novel methodology—multiple picture sorting—to investigate the most relevant characteristics that 

customers identify for differentiating novel logos, and compared them with existing theories. Ninety-

three subjects were asked to classify unknown logos according to criteria of their choice. Most customers 

clustered logos into: (1) composed of brand icon and/or name and (2) coloured or black logos. We then 

used experiments to test whether the logo characteristics identified by customers make a difference in 

logos’ attractiveness. Results show that logos composed of an icon plus a brand name are perceived as 

significantly more attractive than logos made of one component only, and that black logos are perceived 

as more attractive than coloured logos. Thus, customers-identified logo characteristics can guide 

entrepreneurs in designing and selecting logos for novel brands. This study adds to current theory by 

showing that one of the most relevant logo characteristics—brand icon and/or name—has rarely been 

investigated. 

  Logo type  

The Different Types of Logo  

There is more to a logo design than a picture and some fancy fonts, a logo is a brand's visual identifier and 

its sole purpose is to do just that. Potential customers must be able to identify your business, understand 

who you are and what you do just by seeing your logo. If you think of some of the biggest brands out there 



Page 14 of 78 

you will understand what I mean for instance some of my favorite brands to use as examples are Apple, 

Kellogg’s, FedEx, Nike, Adidas, McDonalds etc. 

What makes The Different Types Of Logo Design so unique is the fact that they do their job extremely well, 

they visually identify us with the brand and we know exactly who they are and what they do, and this is what 

I strive for with every logo design I undertake as I want to make them look as big as their biggest competitor. 

Design can elevate a brand and make them look better not only visually but mentally when we think about 

them, the logo sticks in our mind, it creates value and trust. 

Logos are all around us but it’s the certain ones that do their job well that stand the test of time and become 

an iconic design for the brands identity. Now you understand what a logo is for and its purpose let’s take a 

look at some well know logo designs and the type of logo design it is… 

Word mark/Logotype Logo Design 

These are uniquely styled text logos that spell out the company or brand name. Often, custom fonts are 

created specifically for brands to use across all their marketing and branding collateral. Some examples 

include Facebook, Disney and Sony. 

Letter mark / Monogram Logo Design 

Letter marks are exclusively typographic. They use a symbol representing the company through the use of 

its initials or the brands first letter. Many companies choose to use this type of logo because their initials can 

better graphically illustrate the company better than the full name (name is too long), the name is hard to 

pronounce, or it’s just not distinct enough to carry its own weight. Some companies and organizations that 

use letter marks include Hewlett-Packard, Chanel and General Electric. 
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When to use letter mark and word mark logos: 

 Consider a letter mark logo if your business happens to have a long name. Condensing the business name 

into initials will help simplify your design and likewise customers will have an easier time recalling your 

business and your logo. 

 A word mark is a good decision if you’re a new business and need to get your name out there, just make 

sure that name is short enough to take advantage of the design. Anything too long can look too cluttered. 

 A word mark logo is a good idea if you have a distinct business name that will stick in customers’ minds. 

Having your name in a great, designed font will make your brand all the stickier. 

 Both letter mark and word mark logos are easy to replicate across marketing material and branding thus 

making them highly adaptable options for a new, and developing, business. 

 Remember that you’ll want to be scrupulous when creating a letter mark or a word mark. Your business 

name in a font alone likely won’t be distinct enough to capture the nuance of your brand. So make sure 

you hire a professional who’ll have an eye for detail. 

 Symbol / Icon or Brand mark Logo Design 

This type of logo represents the company in a simple but bold manner. In most cases, the image is 

abstract and stylised to give visual interest. Most companies that use this type of logo will have a very 

simple main logo, but may choose to create additional alternative versions that appear a little more 

flashy.  

The human mind can easily remember a simple form much easier than a complex one. It’s best to use a 

simple symbol or icon if you plan on building a large business. You probably recognize symbol logos like 

Apple, Shell and Mercedes-Benz. 

 

When to use picture and symbol logos: 

 A pictorial mark alone can be tricky. It’s effective if you already have an established brand but that’s not 

a hard and strict rule. You can use brand marks to your advantage to convey what your business does 
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graphically if your name is too long, and they can also be used effectively to convey a desired idea or 

emotion. 

 Pictorial and abstract marks also work quite well for global commerce if, for example, a business name 

doesn’t lend itself well to translation. 

 A pictorial mark however may not be the best idea if you anticipate changes to your business model in 

the future. You may start off selling pizzas and use a pizza in your logo but what happens when you start 

to selling sandwiches or burgers, or even produce? 

 Abstract marks allow you to create a completely unique image for your business, but are best left to 

design professionals who understand how colour, shape and structure combine to create meaning. 

 Think about creating a mascot if you are trying to appeal to young children or families. One big benefit 

of a mascot is it can encourage customer interaction so it’s a great tool for social media marketing as 

well as real world marketing events. I mean, who doesn’t want to take a selfie with the Mascot? 

 Remember that a mascot is only one part of a successful logo and brand, and you may not be able to use 

it across all your marketing material. For example, a highly detailed illustration may not print well on a 

business card. So put some consideration in the next type of logo design below, the combination mark. 

Combination Mark Logo Design 

These logos combine a word mark and a symbol or icon to give the flexibility for the use of either or both 

elements across a variety of applications. A well-designed combination mark looks just as good with the 

elements separate as it does with them together. You might recognize some combo marks like Hawaiian 

Airlines, Adidas and Sprint. 

 

Emblem Logo Design 

An emblem logo encases the company name within the design. Some examples include Starbucks, the NFL 

and Harley-Davidson Motorcycles. 
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When to use a combination mark or emblem logos: 

A combination mark is a great choice for pretty much any business out there. It’s versatile, usually highly 

unique, and the most popular choice of logo among prominent companies. 

An emblem’s traditional look might be favoured by lots of public agencies and schools but it can also serve 

any up-and-coming private business quite well, especially those in the food and beverage industry: think 

beer labels and coffee cups (Starbucks!). But remember to play it safe when it comes to detail. You still want 

a design you’ll be able to print neatly across all of your marketing material. 

There it is. A breakdown of all the types of logos out there I hope this has given you a more detailed 

explanation in to the world of logo design and just how much goes in to creating a logo. 

  Logo shape   

Particular logo shapes send out particular messages: Circles, ovals and ellipses tend to project a 

positive emotional message. Using a circle in a logo can suggest community, friendship, love, 

relationships and unity. Rings have an implication of marriage and partnership, suggesting stability 

and endurance 

  Budget  

A budget is an estimation of revenue and expenses over a specified future period of time and is 

usually compiled and re-evaluated on a periodic basis. Budgets can be made for a person, a group of 

people, a business, a government, or just about anything else that makes and spends money. 

 

  Deadlines  

 A line drawn within or around a prison that a prisoner passes at the risk of being shot 

 A date or time before which something must be done 

 The time after which copy is not accepted for a particular issue of a publication 

 

 information 
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Information use" is concerned with understanding what information sources people choose and the ways 

in which people apply information to make sense of their lives and situations. ... Information is defined as 

data (drawn from all five senses and thought) that is used by people to make sense of the world. 

So Knowledge communicated or received concerning a particular fact or circumstance; 

news: information concerning a crime. Knowledge gained through study, communication, research, 

instruction, etc.; factual data: His wealth of general information is amazing. The act or fact of informing 

LO 1.3 – Select tools, materials and equipment  

 
 Content/topic 1: Selection of equipment 

 
 Computer system requirements 

 Memory (RAM)   

Adobe Photoshop 

 

According to the Adobe website, the recommended specs are as follows… 

 CPU: Intel® or AMD processor with 64-bit support*; 2 GHz or faster processor 

Memory: 2 GB or more of RAM (8 GB recommended) 

My opinion: I know from personal experience that using Photoshop with 8 GB of memory is very frustrating. 

I have a laptop that I take with me when I travel. It has an i5 processor and 8 GB of memory, yet it struggles 

to handle Photoshop. Load times are painfully slow for me and there tends to be a lot of lagging and freezing. 

If you want optimal performance, go for 16 GB. I’d even shoot for a 4.0 GHz processor if possible. Photoshop 

runs very smooth on my current i7 rig. 

If you’re on a budget and looking for a machine powerful enough to handle Photoshop with minimal 

slowdown, I would recommend the HP Pavilion Flagship Laptop. 

Adobe Illustrator 
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According to Adobe, the recommended specs for Illustrator are as follows… 

 CPU: Multicore Intel processor (with 32/64-bit support) or AMD Athlon 64 processor 

 Memory: 2 GB of RAM (4 GB recommended) for 32 bit; 4 GB of RAM (16 GB recommended) for 64 bit 

My opinion: Again, I think this is an enormous underestimation of Illustrator’s graphic design computer 

requirements. Although Illustrator has been slightly less demanding than Photoshop in my experience, my 8 

GB laptop struggles with it nearly as badly as it does with Photoshop. I would recommend 16 GB and a 4.0 

GHz processor for Illustrator users as well. 

A good budget laptop that should be able to handle Illustrator smoothly would be the Dell Inspiron FHD 

laptop. 

 

 Processor speed 

Processor. The processor or CPU (central processing unit) directs all the other computer components. 

For graphic design there are two specifications that are important; the number of cores and the speed 

of the processor. In general, you'll want a quad core processor with a speed of 1 gigahertz (GHz) as a 

minimum.   

Display   

For the most part, 250 px (width) x 100 px (height) are the optimal logo dimensions for a web page. 

If, however, you need to customize your logo size, we know how to do it! Below we've listed a 

few logo dimensions for the two most common layouts. 

 Operating System  

        Latest OS: Make sure you're running the latest version—either Windows 7 SP1 or Windows 8.1 Update. ... 

        Processor: 1 gigahertz (GHz) or faster processor  

       RAM: 1 gigabyte (GB) for 32-bit or 2 GB for 64-bit. 

       Hard disk space: 16 GB for 32-bit OS or 20 GB for 64-bit OS. 

       Graphics card: DirectX 9 or later with WDDM 1.0 driver. 

       Minimum free storage space 

       Audio hardware (sound card, speakers, etc) 

 Disk Space  

Windows Minimum  

Graphics card 

GPU with DirectX 12 support 2 GB of GPU memory  

See the Photoshop graphics processor (GPU) card FAQ  
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 Pointer device 

The major pointing device is the mouse for the desktop computer and the touchpad for the laptop, 

although many road warriors bring along a mouse.see mouse, touchpad, trackball and pointing stick. 

 Content/topic 2: Software tools  

 Illustrator  

Adobe Illustrator is a professional vector-based design and drawing program. Used as part of a 

larger design workflow, Illustrator allows for the creation of everything from single design 

elements to entire compositions. Designers use Illustrator to create posters, symbols, logos, 

patterns, icons, etc. 

Adobe Illustrator is the industry standard design app that lets you capture your creative vision 

with shapes, color, effects, and typography. Work across desktop and mobile devices and 

quickly create beautiful designs that can go anywhere—print, web and apps, video and 

animations, and more. 

To download Adobe Illustrator for free. If you're interested in using Adobe Illustrator but 

hesitant to purchase the full version, you can try a free seven-day trial of the product first. 

To do this, simply go to the Adobe Illustrator product page and click “Start your free trial” 

 Photoshop  

Adobe Photoshop is the predominant photo editing and manipulation software on the market. 

Its uses range from the full-featured editing of large batches of photos to creating intricate 

digital paintings and drawings that mimic those done by hand. 

Adobe Photoshop is a software application for image editing and photo retouching for use on 

Windows or MacOS computers. Photoshop offers users the ability to create, enhance, or 

otherwise edit images, artwork, and illustrations 

Photoshop is a paid-for image-editing program, but you can download a free Photoshop in trial 

form for both Windows and macOS from Adobe. With a Photoshop free trial, you get seven days 

to use the full version of the software, at absolutely no cost, which gives you access to all the 

latest features and updates 

 InDesign  

Monitor resolution 1280 x 800 display at 100% UI scaling  

Hard disk space 4 GB of available hard-disk space; additional space is required for installation  
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InDesign is a desktop publishing software application for creating flyers, brochures, magazines, 

newspapers, and books. Projects created using InDesign can be shared in both digital and print 

formats. InDesign is used by graphic designers, artists, publishers, and marketing professionals 

and It can be used to create works such as posters, flyers, brochures, magazines, newspapers, 

presentations, books and eBooks. 

 CorelDraw 

CorelDraw is vector-based designing software that is used for creating logos, flexes, brochures, 

invitation cards and any kind of vector designing based on the lining. 

As a vector graphics editor, CorelDraw is used primarily for marketing and advertising 

businesses, particularly those that specialize in print advertising development. Outside of logos, 

CorelDraw is a program used in the professional space to create brochures, newsletters, 

business card etc 

CorelDraw is user-friendly software which is easier to learn and anyone can learn it. On the 

other side, Illustrator is well-known as a matured version of the software which is not that easier 

to learn. 

 

 

 Content/topic 3: Setting software preference 
In Sketch Up, you can set a few preferences for how the software works overall and how files are saved. 

To access these preferences, select Window > Preferences (Windows) from the menu bar. Most of 

these preferences are on the General pane, which you click in the sidebar on the left. As shown in the 

following figure, your options include saving preferences at the top and Software Updates preferences 

at the bottom. 

 
Figure 7: Setting software preference 

 Creating software workspace 
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To create a new Workspace: 

1. Click your profile photo and select My Profile Settings from the list. 

2. Click the Account tab. 

3. Select Create New Workspace. 

Workspaces refer to the grouping of windows on your desktop. You can create multiple workspaces, which 

act like virtual desktops. Workspaces are meant to reduce clutter and make the desktop easier to 

navigate. Workspaces can be used to organize your work. 

 

 Content/topic 4: Tools and materials  

 Sketchbook  

This logo sketchbook is perfect for logo designers who need a notebook companion so they can 

generate ideas and brainstorm on the go. Designed with gridlines and different sized boxes on each 

spread, this book will help designers stick to the most basic logo design process of going from rough 

comps (small boxes) to tight comps (larger boxes) and to a more polished comp in the largest box. 

Each spread in this 100 page logo sketchbook will have this process pre-lined so that your sketching 

progression is simple and streamlined for each project you take on. 

 Pencils  

Pencil - Meaning of Dream. Pencil is a symbol of new deeds and creativity. If you dreamed of 

a pencil, it is a sign that you are going to experience new achievements and discoveries. Pencil in 

a dream is usually, a symbol of your ability to create own destiny and happiness. 

Pencil is a very important learning tool for children. They learn to write and draw with it. Pencils are 

made of wood, plastic, or metal. There are many types of pencils such as pencils with thick lead and 

thin lead. 

 Ink pens  

A pen is a common writing instrument used to apply ink to a surface, usually paper, for writing or 

drawing. Historically, reed pens, quill pens, and dip pens were used, with a nib dipped in ink. 

Fountain pens work by managing the rate at which the ink flows through the pen. When the pen is 

held at an upright angle, ink from the reservoir is drawn downward by gravity, and goes through the 

feed and to the nib in a controlled fashion. ... The modern fountain pen was born. 

 Tracing papers  

Tracing paper is a semi-transparent paper you can use to trace an image or drawing. Once you've 

traced an image onto tracing paper, you can easily transfer it to another piece of paper or even a 

canvas. Besides vellum, it may be referred to as tracing paper, see-through paper, transparent 
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paper and translucent paper. Whatever you call it, it all refers to smooth, delicate paper you can see 

through. It comes in many colors, weights, brands and even textures. 

 Square  

An instrument having at least one right angle and two straight edges used especially to lay out or test 

right angles 

o A rectangle with all four sides equal 

o Any of the quadrilateral spaces marked out on a board for playing games 

o The product of a number multiplied by itself 

 

 Compass  

an instrument for drawing circles and arcs and measuring distances between points, consisting of 

two arms linked by a movable joint, one arm ending in a point and the other usually carrying a pencil 

or pen. 

 Protractor 

An instrument for measuring angles, typically in the form of a flat semicircle marked with degrees 

along the curved edge. 

LO 1.4 – Arrange the workplace according to the work to be done 
 

 Content/topic 1: Workplace layout and safety 

 Workplace environment cleaning  

Keeping a work environment clean offers numerous benefits related to employee health and safety, 

including: Preventing the spread of germs and illness. Offices can become a significant source of 

bacteria if they are not cleaned regularly. 

Cleaning is the method used to achieve a clean environment. It can best be viewed as a 

fundamental environmental management process of putting unwanted matter in its proper place. 

This ensures an environment that is sustainable and functioning. Cleaning also is a systematic, 

science-based process. 

 Correcting lighting  

In Full Photo Edit or Quick Photo Edit mode, choose Enhance→AdjustLighting→Shadows/Highlights 

and make sure the Preview check box is selected. When the dialog box appears, the default 

correction is automatically applied in your preview. 

 Evaluating ergonomics  
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Ergonomics is the scientific study of people at work. ... Workplace ergonomic evaluations help 

employers recognize ergonomic hazards caused by workplace layout or design that may be 

contributing to an employee's stress or physical discomfort. 

 Arranging computer and accessories  

o Keep only the things you use daily within reach and store everything else off the desk.  

o Organize your drawers and cabinets.  

o Have a filing system to sort documents.  

o Organize your computer too. 

o Create a to-do list. 

o Clear wire and cable clutter 

 Arranging tools and materials 

The first step to organizing tools is to do a thorough inventory. Once you have a general idea of the tools on 

hand, sort them into like categories. Group all of the power tools, the small hand tools, and so on. Next, 

create zones and use cabinetry to keep the like items together. 
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Learning Unit 2 –Create a logo 

 

LO 2.1 – Sketch logo design idea  

 

 Content/topic 1 Brainstorming with sketches 

The definition of a brainstorm is a sudden idea or plan. When you suddenly come up with an idea for a new 

electronic device, seemingly out of nowhere, this is an example of a brainstorm. To brainstorm is to think 

about and try to come up with ideas or solutions to a problem, either on your own or in a group. 

Brainstorming techniques that will help you write creative content 

o Word storm. A word storm is where you write down the words that come to mind when you see 

another word.  

o Word association.  

o Mind mapping.  

o Word banks.  

o Visual association.  

 Content/topic 2- Sketching ideas 
 
A sketch is a quick and rough drawing and gives a brief account or general outline of. Sketching is a rapidly 

executed freehand drawing that is not usually intended as a finished work but is an amazing tool as it allows 

designers to quickly visualize multiple design concepts 

Sketching is a favorite way for graphic designers to come up with some quick and unique design ideas. This 

way, the designers know what is in their mind regarding a particular subject. These instant sketches are 

different design concepts, which can be developed into a complete logo design 

 

LO 2.2 Select and treat typeface 
 

 Content/topic 1: Choosing the right typefaces 

 
Designers already understand the nuts and bolts of typography. They can tell you the difference 

between ‘font’ and ‘typeface’, between ‘mean line’ and ‘baseline’. They might fret over the tracking 

of a particular font, or cringe at subtle kerning miscues that an untrained eye would gloss over. 

However, fewer designers grasp how these mechanics translate to the business decision of selecting 

a typeface. It is more than opting for a font family that is inoffensive to the reader’s eyes – you are 

choosing a fundamental unit of the user interface, the vehicle for a company’s voice. How do you 

capture a mission, a style, a business’s entire essence within a set of characters? 
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 Content/topic 2 Using outline types 

The two main types of outlines are the topic outline and the sentence outline. In the topic outline, 

the headings are given in single words or brief phrases. In the sentence outline, all the headings are 

expressed in complete sentences. 

An outline is a tool used to organize written ideas about a topic or thesis into a logical 

order. Outlines arrange major topics, subtopics, and supporting details. Writers use outlines when 

writing their papers in order to know which topic to cover in what order 

 Content/topic 3 typing around a shape 

 The Custom Shape arrow on the Options bar. 

o Pick Path and then select a custom shape. 

o Select a custom shape. Pick a shape with a simple outline. 

o Draw the shape. 

o Format the text using tools on the Options bar. 

o Click on the edge of the shape. 

o Type and the words bend along the shape path. 

 

 Content/topic 4 Convert type into shape 

Convert text into a shape, right-click on the text layer, and choose “Convert to Shape”. Then select the 

Direct Selection tool (the white arrow tool) by pressing Shift A and click-and-drag the points in the path to 

give the characters a new shape  

I turn an image into a shape in Photoshop? 

 Step 1: Import Image into Photoshop. Select the image that you are going to convert into                   

a custom shape.  

 Step 2: Select Your Proper Tools and Settings.  

 Step 3: Draw the Main Outline of the Shape. 

 Step 4: Draw the Eyes and Mouth. ... 

 Step 5: Convert Image into a Custom Shape.  

 Step 6: Use Your New Custom Shape. 

 Content/topic 5 Transform type shape 

Select what you want to transform. Choose Edit > Transform > Scale, Rotate, Skew, Distort, Perspective, or 

Warp. Note: If you are transforming a shape or entire path, the Transform menu becomes 

the Transform Path menu 

Here there step of transforming types of shape 
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 Choose Edit > Transform. 

 If you are transforming a selection, pixel-based layer, or selection border, choose the Move tool. 

Then select Show Transform Controls in the options bar. 

 If you are transforming a vector shape or path, select the Path Selection tool. 

 

 Content/topic 6: Create typographic effect by combining types 

 
Create Logo in Photoshop 

This part is a logo design tutorial based on Photoshop CC. What if you've installed other versions of 

Photoshop? No worry, its nothing big deal! Just be aware that PS shortcuts remain the same, and such as, 

these steps will be roughly alike. Let's enjoy the journey of Photoshop logo and take a coffee logo as the 

design show. 

Step 1: Instance A Background Layer. 

Open PS CC, and hit [Create New]. Alternatively, keystroke [Ctrl] + N. Enter the name of your logo project, 

along with the width and height. Usually, we set width to 1000 px and height to 1000 px. But you are free to 

input your wanted logo size here. Choose a background color, like 8A7139, for your logo and click [Create]. 
 

                                           Figure 8: How to create a background layer in PS? 
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Step 2: Add Coffee Slogan - Logo Text. 

Add a new layer by selecting [Layer]>[New]>[Layer…], or by using Photoshop shortcut combination: [Ctrl] + 

[Shift] + N. Pick Photoshop Text tool from the toolbox on the left. Type your slogan - your logo text, select 

the font style and font color. It's allowed to change your text to a curved one, the option is right next to font 

color option on the top. But we won't use it this time. 

 
                                                                Figure 9: How to create a logo text in PS? 

Additionally, Photoshop offers a wider range of advanced options for a text, which can be easily found under 

[Advanced]. Here, we just take advantage of these features and fine tune our logo text to make it look stylish. 

To change text position, you can keystroke V letter and move the object. Or double click [T] on the Logo Text 

layer, move mouse cursor outside the text (you will see a change of cursor shape) and drag it to move. 

What's more? Right-click Logo Text layer, go [Blending Options…], then you will find Layer Style windows. 

Just give these styles a try, you may see something interests you. 

   Figure 10: How to customize texts in PS? 
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Step 3: Add Coffee Graphics as Logo Shape. 

For logo shape, we are about to use a part of an image for a cup of coffee. Use [Ctrl] + O to open an image 

that is about coffee. Keystroke W and apply it to the whole coffee cup. Right-click and select [Layer via Copy]. 

It will generate a layer named [Layer 1]. Drag and add it to [Layers] block in previous document. In this case, 

our previous document is Photoshop-Coffee-Logo.psd. 

 

 
 

Figure 11: How to use Photoshop Selection Tool? 

Step 4: Reorganize Logo Text and Logo Shape. 

Resize logo text by applying a larger font size. Make use of shortcut [V] to select any object on your canvas 

quickly. Move their positions on the canvas for a nice look. 

 

 
Figure 12:how to adjust positions in PS. 
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Step 5: Output Your Logo. 

Go [File]> [Quick Export as PNG], or keystroke [Alt] + [Shift] + [Ctrl] + W. 

Useful Tips: Have done something bad in previous step when Photo shopping (Hit [Ctrl] + [Alt] + Z.) 

From these steps, we know that using Photoshop to DIY a logo is workable but not that efficient. Also, note 

that Photoshop has yet fully support outputting SVG logo. 

 Content/topic 7  Wrap type 

Photoshop allows you to create a text wrap around objects and shapes. To create a 

custom text box, you first have to make a shape using the pen tool. After you create the custom 

shape, you can select your text tool and start typing your words. - When using the pen tool, you don't have 

to be exact when making the shape. 

Go to Picture Format or Shape Format and select Arrange > Wrap Text. If the window is wide enough, Word 

displays Wrap Text directly on the Picture Format tab. Choose the wrapping options that you want to apply. 

For example, In Line with Text, Top and Bottom, and Behind Text. 

 

LO 2.3 – Select logo motifs and apply effects 
 

 Content/topic 1: Using basic shapes to build a logo symbols 
 

 Lines 

Line in Logo design is form which logos take on is one composed of lines. Vertical lines feel powerful 

and established, like a stake in the ground. Verticals lines are used to represent superiority and 

strength for an inn and to represent power and rising-up for a supplement company. If your company 

shares these values a logo with vertical lines is a good choice. 

 Geometric shapes 

Geometric shapes can be defined as figure or area closed by a boundary which is created by combining 

the specific amount of curves, points, and lines. Different geometric shapes are Triangle, Circle, Square, 

etc. Before we shift our focus to rather advance and competitive mathematical concepts of geometry and 

algebra, it is important that you acquire the necessary understanding of the geometric shapes. All of us 

know about the common shapes in geometry like a square, rectangle, circle, and triangle. Let us get more 

idea on basic Geometric Shapes. 
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Square 

A square is a four-sided figure which is created by connecting 4 line segments. The line segments in the square 

are all of the equal lengths and they come together to form 4 right angles. 

 

Circle 

On the other hand, a circle which is another shape of geometry has no straight lines. It is rather a combination 

of curves that are all connected. In a circle, there are no angles to be found. 

Rectangle 

Similar to a square, a rectangle is also created by connecting four line segments. However, the only difference 

between a square and a rectangle is that in a rectangle, there are two line segments which are longer than the 

other two line segments. 
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Polygon 

Another in the geometric shapes that you need to know about is a polygon. A polygon is made up of only lines 

and has no curves. It may not have any open parts. In this case, a polygon is basically a broader term to several 

shapes such as a square, triangle, and a rectangle. 

 Start 

 To open and create images 

o In the menu bar, choose File > Open to open existing images. 

o In the menu bar, choose File > New to create a new image from scratch. Select a document preset. 

You can customize the preset by typing in your own values, like width and height. 

I will be showing you the basics of Photoshop. This tutorial is for people who are new to Photoshop and 

want to know the basics of it. 

I will be going over: 

o Creating a New Project 
o Basic Tools 
o Layer, Groups and Guides 
o Filters and Image Adjustments 
o Creating a Wallpaper 

You will need: Computer, Photoshop (I will be using Photoshop CS6) 

Step 1: Creating New Project 
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1. Open Photoshop.  

 

2. Go to 'File > New' or Press Ctrl/Cmd + N. 

3. A window will now open which will have: 

     Name - This is the name of your document. 

 Width - This is the width of your document. 

 Height - This is the height of your document 

 Resolution - This is resolution of your document. 72 PPI is used for Web and 300 PPI is for Print. PPI 

stand for 'Pixels Per Inch' 

 Color Mode - This is the color type for your document. I suggest you leave it as RGB Color for now 

and keep it as 8 Bit 

 Background Contents - This is what your background will be. I suggest you leave it as White. 

 Advance Settings - This is for advance users. You can just leave it as it is. 

4. Once you have selected the setting you want, click 'OK'. 

Here are some common document sizes: 

o 720p - 1280x720 @ 72 PPI 

o 1080p - 1920x1080 @ 72 PPI 

o A4 - 595x842 @ 72 PPI OR 2480x3508 @ 300 PPI 

o A3 - 842x1191 @ 72 PPI OR 3508x4962 @ 300 PPI 

 

 Content/topic 2: Creating Logo motifs 
 

 Seal logo 

https://content.instructables.com/ORIG/FD0/N3FC/HPPSQ1KH/FD0N3FCHPPSQ1KH.tif?auto=webp&frame=1&fit=bounds&md=68c68fcfb996a591bbed8d6debc31dcf
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Show off your brand’s personality with a custom seal logo designed just for you by a professional 

designer. Need ideas, we’ve collected some amazing examples of seal logos from our global 

community of designers. Get inspired and start planning the perfect seal logo design today. 

 Swirls and swooshes 

Swoosh refers to the specific geometrical shapes that are soft and sleek on the edges. Swirls refer 

to the inter-connected pattern of sharp geometrical shapes 

 Custom shapes 

The basic Shape tools allow you to form your photos and projects into rectangles, make circles, 

ellipses and polygons, but Photoshop also offers a Custom Shape tool. This tool allows you to add 

various stock shapes to an image, like music notes, hearts and flowers. 

 Ribbon 

Create a Ribbon Banner 

1. Step 1: Create the middle band of the ribbon banner. In a new layer, create a rectangle using the 

Rectangular Marquee tool (not the Rectangle tool).  

2. Step 2: Create the ends of the ribbon banner. Make a smaller rectangle which is the same height as 

the middle band.  

3. Step 3: Create the insides of the ribbon banner. 

 Shield 

Shields are common in advertising design. We see them everywhere in web as web graphics also. 

They are used as a symbol for assurance, protection, and emphasis for example. Purpose is to create 

a positive impact about the product to buyers or users. Here you will learn how to approach artworks 

like this in Photoshop, where creating photo-realism through Photoshop is the objective. 

Step 1 

Open a new file (File > New) in Adobe Photoshop with the following settings. Save the file as “Shield.psd”. 

During work remember to use often File > Save (Ctrl + S) to save and update the file. 
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Step 2 

Select the Polygon Tool from the Toolbox. Go to the Option Bar above. At the right end, change the Sides 

Field value to 3. Then drag a triangle like in the screen shot below. 

 

Matching exactly is not important. But if you want, then follow along. First open Window > Info. Then click 

on the “Plus” sign besides the X, Y coordinates and select Pixels as unit. Now target the polygon layer in the 

Layers Panel and select the Move Tool (V). Then Menu> Edit > Transform Path > Scale. 
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Now in the Option Bar enter matching values from the screen shot below. 

 

To center the triangle, target both Polygon and Background layer. Click Align Horizontal and Align 

Vertical buttons in the Option Bar. This triangle shape is a vector shape, which consists of points and 

lines. The advantage of working with vector shapes is we can change the shapes later easily by editing 

the points. Next we will edit the three points of this triangle to change its shape into a shield shape. 

(Smith, 2014)  

 

 

 

 Swirls and swooshes 

To move or cause to move around rapidly and repeatedly in a circle. To twist, wind, or twiddle, often 

idly she twirled her hair around her finger. (Often full by around or about) to turn suddenly to face 

another way she twirled around angrily to face him. 
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His backward Nike Swoosh takes its shape from the brand's box logo, because the traditional 

AJI Swoosh extends into the heel and never has an end point. The backward Nike Swoosh takes its 

shape from the brand's box logo, because the traditional AJI Swoosh extends into the heel and never 

has an end point. 

 Custom shapes 

We’re going to create our custom shape by tracing around an object in an image. If you have a natural talent 

for drawing and can draw your shape freehand without needing to trace around anything, great! There's no 

difference between tracing an object or drawing one freehand and there's no benefit to either way of doing 

it (other than bragging rights), but I personally find it easier to trace around objects (I have no natural 

talents), and that's what we'll be doing here. 

 you can create custom shapes in Photoshop using the basic Shape tools like the Rectangle or Ellipse Tool, 

but try tracing our gingerbread man with those tools and you're likely to want to bite his head off (sorry, 

just a little gingerbread man humor). What we really need is the Pen Tool, so select it from the Tools 

palette: 

 

You can also select the Pen Tool by pressing the letter P on your keyboard. 

Step 2: Select the "Shape Layers" Option In the Options Bar 

With the Pen Tool selected, look up in the Options Bar at the top of the screen. Over on the left, you'll see 

a group of three icons: 

 

The three icons in the Options Bar which allow us to select what we want to do with the Pen Tool. 

These icons represent what you can do with the Pen Tool. The icon on the right is grayed out, and that's 

because it's only available when we have one of the basic Shape tools selected (the Pen Tool and the Shape 

tools share most of the same options in the Options Bar). As we saw in our "Making Selections with the Pen 

Tool" tutorial, the icon in the middle is used when we want to draw paths, but that's not what we want to 

do here. We want to use the Pen Tool to draw shapes, and for that, we need to select the icon on the left, 

which is the Shape layers icon: 
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Select the "Shape layers" icon to draw shapes with the Pen Tool. 

The "Shape layers" option is selected by default whenever you grab the Pen Tool so you probably won't 

need to select it yourself. It's a good idea though to check and make sure it's selected before you begin 

drawing your shape. 

 Content/topic 3: Image tracing 

 
Image Trace lets you convert raster images (JPEG, PNG, PSD etc.) to vector artwork. Using this 

feature, you can easily base a new drawing on an existing piece of artwork by tracing it. For example, 

you can convert the image of a pencil sketch you've drawn on paper into vector artwork using Image 

Trace. 

 Content/topic 4: Adding shine, gloss, shadow, texture, bevelled edges, 3D, and transparency 
effects 

Step 1 

Create a new 1250 x 1000 px document. 

Then, create the text in All Caps using the font Franks Regular, and set the Sizeto 280 pt. 

 

Step 2 

If you have more than one line of text, change the Leading value to 250, and change the Tracking to a value 

that you like. Here, the Tracking value of the second line of text is set to 100. 
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. Create the Shape Layers 

Step 1 

Right-click the text layer and choose Convert to Shape. Duplicate the shape layer and rename the copy 

to Stroke. 

 

Step 2 

With the Stroke layer selected, pick the Direct Selection Tool. In the Options bar, change the Fill to None, 

the Stroke Color to #e5bf25 , its Sizeto 2, and click the Set shape stroke type icon to change 

its Align to Outside. 
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Create the 3D Layers 

Step 1 

Select each shape layer you have and go to 3D > New 3D Extrusion from Selected Path, to convert it into a 
3D layer. 

 

Step 2 

Select both 3D layers and go to 3D > Merge 3D Layers. 
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Step 3 

To access the 3D mesh settings and properties, you’ll need to open two panels: the 3D panel and 

the Properties panel (both found under the Window menu). 

The 3D panel has all the components of the 3D scene, and when you click the name of any of those, you’ll 

be able to access its settings in the Propertiespanel. So make sure to always select the tab of the element 

you want to modify in the 3D panel before you change its settings in the Properties panel 

LO 2.4 Choose logo colors 

 Content/topic 1: Creating colour schemes 

 Logo colour association 

Choosing the right logo colour can highlight your business’ strengths and help you attract the right 

customers. And, as you might guess, the wrong combination can have the reverse effect. 

Everyone has heard of colour psychology, which tells us that colours impact our emotions and behaviours. 

Yellow is cheerful (because the sun is bright and yellow!) and green is calming (like laying in the grass and 

looking up at a bunch of leaves is peaceful). But do these logo colour “rules” really mean anything in business 

and branding 

 Colour consistency 

Why color consistency is important in branding 

If the colors vary across different channels you can lose out on recognition, which in turn will impact 

sales and present a disorganized and unprofessional image. Consistent brand coloring can massively 

increase brand identification, boosting sales and engagement. 

 Combining colours 

Here are some of our favorite two-color combinations. 

 Yellow and Blue: Playful and Authoritative 

 Navy and Teal: Soothing or Striking 

 Black and Orange: Lively and Powerful 

 Maroon and Peach: Elegant and Tranquil 

 Deep Purple and Blue: Serene and Dependable 

 Navy and Orange: Entertaining yet Credible. 

 Communicate through Color 
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A colorful gradient makes me think of a blend of sherbet flavors. With the rounded rectangle 

selected, click the color fill (in the Properties Panel) and then the gradient icon. Specify the type of 

gradient you want, such as Linear or Radial, and the angle of rotation. Click the gradient color strip 

to change and add colors. Double-click the first color stop, specify a color value, and click OK. Use the 

same steps to change the last color.  

Add two more color stops by clicking just below the gradient bar, and then change the color. 

 

 
Learning Outcome 2.5: Prepare logo for use and Export 

 Content/topic 1: Creating black and white alternations 

The first method of creating black and white photos is to use the Black and White Adjustment Layer. 

First introduced in Photoshop CS3, the Black/White Adjustment Layer desaturates a photo and allows 
you to control how the grays of each color is represented. 

 

This adjustment layer is one of the best tools to convert color photos into black and white. 
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Step 01 – Make a Black and White Adjustment Layer 

Start by creating a Black and White Adjustment Layer. From the Layers Panel, click on the New 
Adjustment Layer icon and select Black White. 

 

             Step 02 – Adjust the Colour Slider in the Properties Panel 

The Black and White adjustment layer will desaturation your image. In the Properties Panel, you’ll 
notice six sliders: Reds, Yellows, Greens, Cyan, Blues, and Magentas. These sliders control the 
brightness of the grayscale version of the corresponding colors. 

 

For example, moving the Red slider to the left, darkens the pixels that initially had a shade of red. 

You can use the slider to create better contrast and tonality in your image. For example, if you want 

a darker more dramatic sky, you can click-and-drag the Blue slider to the right. 

 



Page 44 of 78 

 

Step 03 – Use On-image Adjustment Tool 

Instead of using the sliders to adjust the tonality of your photo, you can click-and-drag over the image 
to adjust a particular area. 

To adjust a specific color in your photo, you can select the On-image Adjustment Tool found on the 
top left of the properties panel. 

 

Then click-and-drag directly over your image to modify the color slider for the predominant color at 

that location. Dragging to the left makes the selected section darker while dragging to the right makes 

it brighter. 

Reverse logo file formats 

If you’re about to get a logo designed I highly recommend asking for a reverse format when discussing 

your logo brief with your designer. I always include a reverse logos as standard with my final file drop 

when working on branding projects for my clients. Reverse logos are often supplied in the following 

file types: 

.EPS [Encapsulated Postscript] 

Always ask for an .eps file of your reverse logo. An .eps file is a vector file, which in short means that 

it won’t lose quality if scaled up or down, from tiny website browser favicons to large scale signage 

or banners, making it a super useful file format. [See my blog about vectors and raster’s for more 

detail]. Note:  Unless you have image editing or design software you might not be able to see a 

preview of this file, and if the reverse logo is completely in white, the preview will most likely look 

like just a plain white field. 
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   .PNG [Portable Network Graphic]  

    A .png is a raster file format that allows you to preserve transparency. A .png copy of your reverse logo 

is useful for digital graphics like websites and social media as their low resolution and RGB colour profile 

usually means a smaller file size and good rendering on screen. 

Note: .jpg file formats don’t retain transparency, so you won’t be receiving one of these for your reverse 

logo.  

    .PDF [Portable Network Graphic] 

You might be supplied a .pdf copy of your reverse file by your designer, which should work in the same way 

as the .eps vector file but I personally find that supplying the .eps sufficient for most purposes. 

S U M M A R Y  

Reverse logos are a super useful version of your logo design and really a must-have as part of your branding 

package. I strongly recommend including a request for a reverse format copy of your logo design in your 

brief and then make sure you get an .eps vector copy of it at the very least with your final design handover. 

  prepare usage guideline 

o Choose View > New Guide. In the dialog box, select Horizontal or Vertical orientation, enter 
a position, and click OK. 

o Drag from the horizontal ruler to create a horizontal guide. 
 

 Prepare print ready file 

Creating print-ready pdfs Adobe Photoshop CC 

1. Make sure the file is in CMYK mode: Image > Mode > CMYK color. 

2. Flatten your design. In the layers palette drop down menu (img.) 

3. Image > Save as. Set format to Photoshop PDF. ... 

4. Start with the High Quality Print Adobe PDF Preset. ... 

5. Click Save PDF (img.) 

 Go to: File / Save as under Format select 'Photoshop PDF' save, this takes you to the 

'Export Adobe PDF window, under 'Adobe PDF Preset' select 'PDF/X-4:2008' then Save PDF. 

 Prepare Screen files 

Create Layers for Each Color. The most reliable way to produce artwork for screen printing is to 

manually prepare it in Adobe Illustrator. Each of the three colors is going to form a separate 

artwork in a separate layer, using elements from the main image for each color. 

 Organize logo files 



Page 46 of 78 

Before you compress your files, organize them into folders so that it's easy for the client to find 

what they need. One handy way to do this is to put each version of the logo in its own folder with 

all files types, then compress them all together in one big ZIP (not . rar) file. 

 Content/topic 2: Organize logo files 
 

The best way is to export as SVG.  Scalable Vector Graphics have a smaller file size, better image quality and 

can be re-scaled to any size (up or down) while preserving crisp details.  You cannot do that with raster 

images JPG or PNG without sacrificing quality.   

SVG is an XML based code that can be enhanced in any code editor like Dreamweaver or Brackets to add 

text, links and even CSS animations.  SVG is supported by all modern browsers and is perfect for icons, logos, 

info graphics and responsive image maps. 
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Learning Unit 3 - Prepare for designing a banner 

 

LO 3.1 Specify requirements and considerations 

 Content/topic 1: Consider the placement of your banner 

 
A banner is a piece of cloth, usually long and elaborate, which contains a flag or a slogan or a message of some 

sorts. In ancient times, a banner was used to dictate the rules or slogans of rulers and dictators. As a matter of 

fact, if you visit an old castle today, you’re sure to notice a few old banners here and there. The term banner 

has been derived from the French word “banner”, basically meaning cloth. 

Today, the term banner is used to refer to any piece of shiny or colourful cloth which displays a logo or a 

message of some sort. For example, you will come across countless Wedding Banner Templates during 

political elections. Banners containing pictures and slogans of a particular political leader is put up. All academic 

institutions also have banners of their own. It basically serves as a mark of identity, it represents the institution 

or the individual and can be considered as a form (template, 2020). 

 Consider the placement of your banner 

Banners and banner stands can have a place in almost any type of business, and whether you are a B2B or B2C 

organization, there’ll always be some way for you to get the most out of banners and banner stands. From 

inside your place of business, to the entrance or even a trade show, banners and banner stands can be a great 

way of grabbing the attention of your customer. Catching your customer’s eye and getting their attention takes 

more than some colorful graphics or big offers; where you place your banner will also have an effect. 

 Choose bright & contrasting Colors 

o Yellow and Blue: Playful and Authoritative 

o Navy and Teal: Soothing or Striking.  

o Black and Orange: Lively and Powerful 

o Maroon and Peach: Elegant and Tranquil 

o Deep Purple and Blue: Serene and Dependable 

o Navy and Orange: Entertaining yet Credible 

 Choose a bold and readable Font  

o Arial is a popular sans-serif typeface that features natural strokes and open counters to give it a more 

organic look 

https://www.template.net/design-templates/print/wedding-banner-sample/
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o Droid Sans was designed with open counters, tall x-heights, and a sturdy structure to make it highly 

legible on mobile devices. 

 Keep the copy simple 

Clear, easy and simple writing is an art. It not only helps the reader but is also a smart approach to 

writing.  Your writing will be meaningless if you are not able to send your messages to your readers. An easy 

and simple copy helps the readers to understand the topic. To write a simple copy, you may follow the 

following instruction 

o Write short 

o Be precise and exact 

o Use easy and lucid language 

o Use conversational tone 

o Avoid Jargon or register (special word for special field), rather describe the word 

o Use examples 

o Present visual images to describe your writing 

o Use familiar words 

o Try to make the writing interesting 

o If possible, show some surveys, pictures or charts 

o Avoid slang 

o Avoid parallel sentence construction, weak verbs and double negatives 

o Use active voice 

o Use acronyms and abbreviation. If possible, explain the acronyms and abbreviations 

o Check the spelling and grammar 

o Finally, give a nice clear finish to your writing. 

 Use a call-to-action  

Calls to Action, also known as CTAs, are specific phrases that encourage someone to take a desired 

action. They are the key to the success of any effective digital marketing program. CTAs typically 

involve a click on a button and are designed to guide users towards a particular goal or to prompt an 

immediate response. 

 Content/topic 2: Types of banners 

 Vinyl banners 
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Vinyl banners are a form of outdoor advertising. Most banners are now digitally printed on 

large format inkjet printers which are capable of printing a full color outdoor billboard on a 

single piece of material. 

 Custom vinyl banners 

Our custom vinyl banners are hard to miss no matter where you hang them. Choose from 16 

different sizes that can be printed horizontally or vertically. If you’re displaying your banner 

in a store, the indoor vinyl is your go-to. If you’re trying to draw attention outside, go with 

the extra-thick outdoor vinyl. Pair with reinforced edges and grommets to ensure your banner 

stays safe and secure. 

 Double sided banners 

Two sided banners include: Printing on both sides. Printing on both sides of a single layer of 

vinyl. Each side can be printed with its own graphics or be printed with the same image on 

both sides. 

 Teardrop banners 

Teardrop flags, commonly referred to as teardrop flag banners or teardrop feather flags, are 

large teardrop-shaped flags with any custom design printed on them using a dye sublimation 

process. ... Advertising your business is made simple and effective with these teardrop flag 

banners. 

 Outdoor banners  

Vinyl banners are the most durable and commonly used banners for outdoor display 

purposes. Choose between a 13 oz. and 18 oz. vinyl to print on, depending on your intended 

use. Typically, the heavier the material, the greater the durability. 

Making an online banner with Canvas is easy. Whether you're wanting to dress up your 

Facebook, Twitter, YouTube or LinkedIn profile, our drag-and-drop editor allows you to 

customize thousands of free banner templates to match your brand's visual identity—you 

choose the layout, colors, font, and images. 

 Sports break away banners 
Our Custom Breakaway Banners are a fun way for your team to make a memorable entrance 

to the big game. Also known as run-through banners, these breakaway banners are durable, 

weatherproof & reusable. Use year after year! 

Victory Store offers custom breakaway banners as well as stock designs for football! Send us 

your logo, or you can contact us to have our graphic designers create something just  for your 

team! 
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Content/topic 3 : Types of Banner stands 

 Pull up banner stands  

A pull up banner stand is one that you simply pull up and can set up in a matter of seconds. They can 

also be known as roll up or roller banner stands and tend to be 2 meter’s high with differing widths 

depending on your needs. This can be printed on one or two sides and are much cheaper than their 

pop up alternatives. 

 X banner stands  

X banner stands are used to display large format banners within a trade show or retail 

presentation. These exhibition stands, X banner stands have an adjusting design you can 

manipulate to display a range of different-sized banner graphics. 

 Indoor banner stands  

Banner Stand for Indoor & Outdoor Use Holds Up to A 27"w x 82"h Banner - Grey - Banner NOT Included 

This banner stand is designed to hold banners up to 27"w x 82"h. (Banner NOT Included) Constructed of light 

weight yet durable aluminum and with a plastic base these units are built to be portable. Once set up in the 

location you want to present your graphic, simply add water or sand to the base (6 gallon capacity) for added 

stability. The horizontal banner arms adjust from between 17-1/2"w to 27-1/2"w and the vertical adjustment 

is from 43" tall to 82" tall. A truly adjustable banner stand that is affordable and reusable. 

 Outdoor banner stands 

Outdoor banner stands are a popular type of portable outdoor display. Unlike banner stands for indoor 

display, outdoor banner stands have some type of weighted base or design to allow the displays to 

remain stable in the wind. This category includes outdoor retractable banner stands, portable banner 

stands with bases that can be weighted with sand or water, and the popular feather and teardrop flag 

banner stands, also called flying banners or beach banners. We also offer outdoor tents with solid color 

or custom printed canopy tops and pop up a frame banners that also have their own category due to 

their unique nature. 

Our outdoor retractable banner stands include a few exclusive models that bring the convenience of roll up 

banner stands to the world of outdoor display. We've offered models in this category for years, but they 

were so expensive that not everyone could afford them. Because we see indoor banner stands constantly 

being used outdoors, and because they don't hold up well in that situation, we had our own models created 
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so they would be practical for many more customers. While our models are all designed for double sided 

use, they can also be used single sided by only using a banner on one side. 

 Hanging 

Hanging has been practiced legally in the United States of America from before the nation's birth, up 

to 1972 when the United States Supreme Court found capital punishment to be in violation of the 

Eighth Amendment to the United States Constitution.  

 Banner 

A banner is a flag or other piece of cloth bearing a symbol, logo, slogan or other message.  

Church banners commonly portray the saint to whom the church is dedicated. The word derives from 

French word "bannière" and late Latin bandum, a cloth out of which a flag is made. 

Learning Outcome 3.2:– Select tools, materials and equipment  
 

 Content/topic 1: Design software applications 
 Adobe Photoshop 

 
Adobe Photoshop is a software application for image editing and photo retouching for use on 

Windows or MacOS computers. Photoshop offers users the ability to create, enhance, or 

otherwise edit images, artwork, and illustrations 

 Adobe InDesign 
InDesign is a desktop publishing software application for creating flyers, brochures, magazines, 

newspapers, and books. Projects created using InDesign can be shared in both digital and print 

formats. InDesign is used by graphic designers, artists, publishers, and marketing professionals 

and It can be used to create works such as posters, flyers, brochures, magazines, newspapers, 

presentations, books and eBooks. 

 Illustrator 

Adobe Illustrator is a professional vector-based design and drawing program. Used as part of a larger 

design workflow, Illustrator allows for the creation of everything from single design elements to 

entire compositions. Designers use Illustrator to create posters, symbols, logos, patterns, icons, etc. 

 Content/topic 2: Computer  
 

A computer is a machine that accepts data as input, processes that data using programs, and outputs 

the processed data as information. Many computers can store and retrieve information using hard 

drives. Computers can be connected together to form networks, allowing connected computers to 

communicate with each other. 
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 Content/topic  3 Drawing book 

A sketchbook is a book or pad with blank pages for sketching and is frequently used by artists 

for drawing or painting as a part of their creative process. 

Excellent Drawing Books for Kids 

o Ed Emberley's Drawing Book of Animals by Ed Emberley. 

o Adventures in Cartooning: How to Turn Your Doodles Into Comics by James Sturm and Andrew 

Arnold.  

o Oodles of Doodles: Over 200 Pictures to Complete and Create by Nikalas Catlow.  

o My First I Can Draw by Thomas Nelson. 

 Content/topic 4  Drawing pencil 

Sketches can be made in any drawing medium. The term is most often applied to graphic work 

executed in a dry medium such as silverpoint, graphite, pencil, charcoal or pastel. 

 

LO 3.3 – Arrange the workplace 
 

 Content/topic 4 : Workplace layout and safety 
 

 Workplace environment cleaning  
 

Cleaning is the method used to achieve a clean environment. It can best be viewed as a 

fundamental environmental management process of putting unwanted matter in its proper place. This 

ensures an environment that is sustainable and functioning. Cleaning also is a systematic, science-

based process. 

1. Conduct top-to-bottom cleaning. Top down cleaning helps reduce cross contamination and the need 

to re-clean areas. 

2. Choose products carefully. It's important to invest in high-quality and sustainable restroom products 

to reduce waste while supporting cleanliness. 

 Computer arrangement 

An arrangement is defined as a combination of things that make up a design or that are laid out in a certain 

way. The V-shape made by flying geese is an example of an arrangement. The definition of an arrangement is 

something that has been planned. An appointment is an example of an arrangement. 

 
Tool design is a specialized area of manufacturing engineering comprising the analysis, planning, design, 

construction, and application of tools, methods, and procedures necessary to increase manufacturing 

productivity. 

  The tools used in layout designing?  
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o Sketch Up is an intuitive online floor design tool that enables users to create custom 3D layouts in a 

jiff.  

o Home Style is high on the list of outstanding free 3D programs. ... 

o Planner 5D.  

o Planning Wiz Room Planner 3D. ... 

o Ikea Planner Tools. 
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Learning Unit 4: –Create Banner 

Learning Outcome 4.1: Illustrate to produce a banner layout and design blueprint 

 Content/topic 1: Improving banner design according to defined purpose 

Before I will cut deeper into the subject of designing a banner ad, I would like to clarify something about 

banner advertising. In this part of the digital industry,[Tweet “your banner ads are the defining elements of 

your marketing strategy’s success.”] 

Imagine that you are building a house. Your banner ads serve as the foundation of the house and the walls 

will be made of different settings of your campaign according to the targeted audience. The roof of your 

house represents the return on investment (ROI). If the base is unsteady, your walls will tremble and your 

roof will collapse. 

Your banner ads, as the core element of your advertising campaign, should be strong enough to create a 

steady foundation for your whole marketing strategy and to help you reach your goals.  

Have you defined your goals before you started to design your banner ads? 

If not, you will easily throw away a huge amount of money without winning anything back. 

You may find this statement exaggerated, but there are certain reasons why defining your goal is one of the 

most important things to do in the process of designing your banner ads.  

A well-defined purpose will help you to bring out more of your banners because you will keep working on 

them until you reach your goal. 

 Content/topic 2: Improving by simplifying the design 

Simplifying a design means to reduce its complexity. ... For example, counting the components of 

a design can be a measure of complexity defined for the context of manufacturing, in the aspect of structure: 

it characterizes the number of components that have to be manufactured before the design can be 

completed. 

Relevant Imagery 

While custom photography is the best option, sometimes budgets only allow for stock photography. But if 

you’re not careful, tacky, cheesy, generic stock photos can create the wrong idea about your brand. When 

using stock imagery, stick to images that are relevant to your message and avoid the obvious, too happy, 

overly posed images in favor of the more conceptual images. 
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When using images on your website, don’t just think about one image on a single page. Think about the 

website or sales page as a whole. Images used throughout your website should have a consistent style, 

include a consistent colour, or be a consistent shape. 

To visually guide visitors’ attention to a specific piece of content, use an image with a visual cue pointing in 

that direction. This is called gaze focusing. For example, an image to the left of a call to action should visually 

point or lead to the right, directing the visitors’ eye to the call to action. 

When featuring facts, figures, studies, statistics, or technical information consider using charts, graphs, info 

graphics, and screenshots to visually communicate the data and make it easier for readers to understand 

the information. 

 Content/topic 3: Generating final thoughts 

Web Tools for Generating Amazing Banner,  there are many alternatives for you to try when it comes 

to design your own banner ads but we will discuss here the most popular ones. 

 Flexitive 

 Canvas 

 Banner snack 

 Banner flow 

 Footer 

 Html5maker 

 Animation 

Some of them are based on templates; others offer you editors with a blank canvas to set your own rules. It 

all depends on your designing skills and your budget, but let’s see how efficient it can be every tool for your 

plan. 

In addition to the concluding statement, the writer may wish to include a "final thought." The final thought is 

the last sentence of the stand-alone paragraph. If the writer has not had an opportunity to interject an 

opinion about the topic, the final thought is the last opportunity to do so. 

Learning Outcome 4.2: Organize and select image assets and typefaces 

 Content/topic 1: Types of fonts  

 Helvetica   
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Many designers (including this one) consider Helvetica to be one of their go-to typefaces, but at one 

point does a love for the neo-grotesque become an addiction? The first step is always admitting that 

you have a problem. 

 Content/topic 2: Inserting images 

This tutorial will give you general overview of what you need to know about images and the Site builder. 

You'll learn about uploading images, using custom images for your banner area, placing images on your 

pages, compressing and saving files for web use, different photo widgets available, and also managing your 

files with the File Manager. 

Changing the Banner 

Many of our styles allow you to customize the banner image. Mousover your banner area and take note of 

the pixel dimensions for the banner (e.g., the "Heirloom" style's banner image is 870 x 348 pixels) and upload 

a scaled photograph or create and upload your own graphic. Your custom graphic may include your company 

logo and/or additional visuals. 

 

Figure 13: Changing the Banner 

To change the banner image, click directly on the default banner image. The Style Designer will open up on 

the left-hand side. Under the "Colors" section, click on Banner Image. This will open the Banner Editor Dialog 

box, allowing you to select your image. 

You will be able to manipulate your banner picture to fit the specified banner dimensions. Once done, 

click save in the Style Designer and your banner image will be added to your page. 

Please note that you can use the default banner picture of the style if you wish. 

For more information on adding banners and backgrounds, take a look at this tutorial: Personalize your Style. 

https://www.yola.com/tutorials/article/Personalize-your-Style/Basics_getting_started
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Inserting Pictures 

You can insert individual pictures in one of two ways: 

1. Picture widget 

Drag and drop a Picture widget onto your page. The Picture widget is located in Widgets and 

selecting Popular from the drop-down menu. The File Manager will open up, allowing you to either select 

an existing picture or to upload a new one from your computer. 

 

 

Figure 14:Picture widget 

  

Now you can move the position of the picture, add a link and alt text, using the Edit link on the top left-

hand corner of the Picture widget. You can also adjust the top, bottom, left and right margins, which is 

useful if you don't want the graphic to sit against another page element, such as a block of text. You can 

access this feature by clicking on the Margin link on the Picture widget. 
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To link your picture to another page, external URL, email address or file, click on the Edit link and then select 

the Choose a Link button.You can also add Alt Text to your image. The Alt Text attribute specifies alternate 

text that is shown when the image cannot be displayed. Alt Text should describe the content of the image, 

so type something appropriate into this field. For example, if it's a company logo type in the company name, 

if it's a photograph of one of your products type in the product name and a short description of the product. 

 

 

 

2. Text widget 

Another way to insert pictures into your pages is by using the Picture button on the Text Editing Toolbar when 

using a Text widget.  

Drag the Text widget (located in Widgets and selecting Popular from the drop-down menu) onto your page. 

Insert your cursor into the Text widget box and click on the "Picture" button on the Text Editing Toolbar. You 

can either Upload New Image or Browse Uploaded Images. Click on the image you wish to use 

and click Select.  

 

 

 

This is an ideal way of inserting graphics into pages, as it shows the picture dimensions (in width and 

height) as you drag it to scale. This makes it really easy to insert several pictures of the same height into a 
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row which is useful for thumbnail pictures that look uniform and neat. It's simple to alter the picture 

alignment (choose left, center or right alignment) in the Text Editing Toolbar. 

 

To add a link to your picture, select it and click on the Link button (next to the Picture button) on the Text 

Editing Toolbar. 

 

 

To resize the picture proportionately just drag any of the corner nodes (a black corner frame and arrow will 

appear as you hover). 
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You can also place a picture and text side by side (text wrapping): 

1. Once you have added your picture, select it by clicking on it. 

2. You will then see two new buttons on your Text Editing Toolbar: A picture with text on the right (Wrap 

Left) and text on the left (Wrap Right). 

3. Select the option that suits you and start typing. 

4. Your text will then wrap around the picture. 

 
 
Photo widgets 

It couldn't be simpler to add photos to your website! We offer a number of photo gallery type of widgets 
for you to use on your site. 
 
Going to Widgets and selecting Media from the drop-down menu, you'll find the Gallery widget.  

Gallery widget 

With the Gallery widget, you no longer have to drag and drop individual photos and resize them on your site, 

or use a third party application to create a photo gallery. 

 

You can locate the Gallery widget by going to Widgets and selecting Popular or Media from the drop-down 

menu. Drag and drop this widget onto your page. Then, you can choose to upload a new image or browse 

through your File Manager. If you wish to upload several images at once, hold down "ctrl" (for PC users) or 

the "cmd" key (for Mac users), while clicking on the pictures you would like to upload. Once you have 

selected your images, the gallery will display immediately.  
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The Gallery widget also allows you to edit the hover text, style and margins of your gallery. 

Please note: If you choose a style with rounded corners, the rounded corners will only display on the 

thumbnails - the larger images will display with standard, square corners.  

 

 

  

For a further in-depth tutorial on how to use this widget, please visit this link: Tutorial: Using the Picture 

Gallery Widget. 

Flickr Search 

Flickr is one of the most popular online photo management and sharing applications in the world, so we've 

made it easy to add photos from Flickr to your website. 

 

Drag and drop the Flickr Search widget (located by going to Widgets and selecting Media from the drop-

down menu) onto your page and click on Edit on the widget to access the Properties. By default, the widget 

displays random images from the Flickr pool. You need to insert your email address (as configured with your 

Flickr account) into the User's email field. In addition you can further refine your search by typing in a Search. 

Phrase to enable the widget to look for specific images within your pool. 

 

Alternately, you can display images that are not from your account by typing in a search phrase (e.g., dogs). 

The Max Results is set to 30 so that there is a long block of images. Now you can fine-tune the placement 

of the widget on your page by altering the margin and alignment. 
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A more advanced feature is the Flickr widget which enables you to add a gallery of your Flickr photos - for 

more information, please see our tutorial on Flick Galleries. 

 

 Learning Outcome 4.3: Combine creative software tools 
 

 Content/topic 1: Types of creative software and their differences 

 Illustrator  
Adobe Illustrator is a professional vector-based design and drawing program. Used as part of a larger design 

workflow, Illustrator allows for the creation of everything from single design elements to entire 

compositions. Designers use Illustrator to create posters, symbols, logos, patterns, icons, etc. 

 Photoshop  
Adobe Photoshop is a software application for image editing and photo retouching for use on Windows or 

MacOS computers. Photoshop offers users the ability to create, enhance, or otherwise edit images, artwork, 

and illustrations 

 InDesign  
 
InDesign is a desktop publishing software application for creating flyers, brochures, magazines, newspapers, 

and books. Projects created using InDesign can be shared in both digital and print formats. InDesign is used 

by graphic designers, artists, publishers, and marketing professionals and It can be used to create works such 

as posters, flyers, brochures, magazines, newspapers, presentations, books and eBooks. 

 

 

 Content/topic 2 : Combining software tools 

 Using Photoshop  

All of the program elements, with the exception of menu bar, can be dragged around and docked 

with other panels to create your own custom work area called a workplace. These are a number of 
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pre-set workspaces that can be selected from the right hand side of the menu bar, the default 

workplace is called “Essential” and can be recalled at any time by clicking on the button. This is very 

useful because beginners will often accidently close or collapse panels and can’t remember how to 

restore them. 

 

 
 Sizing the banner, and resolution 

Size a banner in Photoshop? 

Step 1. Create new document In Photoshop, select File and New. This will open a New File window 

where you can select all the properties of your banner.  

Step 2. Select size (we chose 8ftx2ft) and resolution (in this case, 120 pixel/inch is enough given 

that this banner will be seen from a distance of approximately 10ft). 

 

On larger banners and graphics PPI (DPI) can be reduced significantly. Ideally resolution on small to 

medium graphics should be around 100-125 PPI (DPI), while on larger graphics (say 10m x 1m) a 

resolution of 80 PPI (DPI) (80 PPI (DPI) will be more than adequate. 

Good resolution size for Photoshop is 300 pixels/inch 

The generally accepted value is 300 pixels/inch. Printing an image at a resolution of 300 pixels/inch squeezes 

the pixels in close enough together to keep everything looking sharp. In fact, 300 is usually a bit more than 

you need. 
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A high-resolution image is anything that has at is 300 dpi high resolution with a larger pixel dimension, for 

example, 5000 × 4000 pixels. If you have an image that is 640 × 40 at 72dpi, you definitely have too small of 

an image! 

 
 Insert images 

This is how to open an image and place an image in Photoshop. Opening an image in Photoshop will open 

an image to be editing. Placing an image will insert an image as a new layer in an existing Photoshop file. 

This is useful if you are combining elements of an image. 

 

 

 

Upload a single photo from your computer, Google Drive or Dropbox. Add a text or a logo.  

Edit your text or logo using the editing toolkit. Drag your text or logo to any place within the picture.  

Click on "Save image" and download a copy of your image with the text or logo. 
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You already have an image that you would like to use in your Photoshop project, add it as a new layer. 

1. Open or create the Photoshop project that you want to edit. 

2. Drag and drop the new image into the Photoshop window. ... 

3. Press the “Enter” key to confirm and add the image as a new layer. 

 

 Adding text  

Add new text in Photoshop. 

1. Step 1: Select the Type Tool. First select the Type Tool from the Toolbar: ... 

2. Step 2: Click in the document to view the live preview. ... 

3. Step 3: Choose a new font. ... 

4. Step 4: Choose a type size. ... 

5. Step 5: Add your text. 

 Changing the background color  

Open Photoshop and choose "File" > "New" to start a new project. In the New dialog box, click on 

the section called Background Contents and select a background color. By default, the color will 

be set to "White", but you can also choose a preset color or a transparent background. 

 Changing the Background Color. 

1. Step 1: Select the subject. Draw a rectangle around the subject. 

2. Step 2: Invert the selection.  

3. Step 3: Click inverse menu.  

4. Step 4: Press delete key. 

5. Step 5: Open color picker. 

6. Step 6: Select color. 
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7. Step 7: Select brush. 

8. Step 8: Start brushing. 

 Saving the file
Go to: File / Save as under Format select 'Photoshop PDF' save, this takes you to the 

'Export Adobe PDF window, under 'Adobe PDF Preset' select 'PDF/X-4:2008' then Save PDF 

Steps of saving the files 

Step 1. Saving the file Select File then save as 

Step 2. A Save As window will open.  

Step 3. Save the file in Photoshop format first, so you can make any changes to it in the future.  

Step4. Then go to layer - flatten image and repeat the process (File>Save As...) and save it in 

the Photoshop PDF format. 

Learning Outcome 4.4 -Select colors 

 

 Content/topic 1 : Classifications of colors 

 Primary  

 Secondary  

 Tertiary  

 Types of color schemes  

 Monochromatic 

 Tertiary 

 Content/topic 2: Using Color contrast 

Choose bright & contrasting Colors using Photoshop 
 

 

file:///C:/Users/IT_BYIGOD/Desktop/LOGO/logo%20design/ICTCOA3001_COALB301.docx%23Changing%20the%20Banner
file:///C:/Users/IT_BYIGOD/Desktop/LOGO/logo%20design/ICTCOA3001_COALB301.docx%23Changing%20the%20Banner
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This short guide on how to design a banner will help people with little or no design experience to make one 

on their own. Follow these easy steps one by one and you’ll have a print ready banner designed in no time. 

Step 1 

Create new document In Photoshop, select File and New. 

 

 

 

 

 

 

This will open a New File window where you can select all the properties of your banner. Select size (we 

chose 8ftx2ft) and resolution (in this case, 120 pixel/inch is enough given that this banner will be seen from 

a distance of approximately 10ft). The further away the viewer will stand, the lower the resolution can be. 

This way you won’t end up with a massive file. If you’re not sure which resolution to select, talk to your 

printer. 

Make sure your colour mode is CMYK. That’s the mode used for printing and background contents is set to 

white for a white background. 

 

Once you click the OK button a layer like this will open. 
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Step 2 
Insert an image                            Select File and Place 

 

A Place window will open. Select an image of your choice and click Place. 

 

 
The picture you selected will appear on your banner like this. 
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To move the picture simply click and drag. To re-size it hover over one of the corners of it until the cursor 

appears as a double sided arrow. Tip - Hold shift and drag to re-size proportionally. 

 

By repeating the process you can add as many images as you like. Here we added the logo. 

 

In case you want to re-size the photo after you place it select edit then Free Transform. 
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And the bounding box will re-appear. 

 
 

Step 3 
Adding text     Select the type tool from the side menu. 

 

Click anywhere to on the banner to start typing. 

 

Once you’re done confirm the action the same way you did with placing images. 
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To move text around select the layer it’s on (on your right side) and the move tool from the left hand side 
menu, then click and drag. 

 

Repeat the process to add more text if needed. 

 

You can resize text the same way you resized pictures (Edit>Free Transform) and move it around using Move 
Tool. 

 
 

Step 4 
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Changing background colour                                              

Select the paint bucket tool from the left hand side menu and the background layer. Pick the colour either 
from swatches or the colour mixer. 

 

Simply click on the banner to change the colour of the background. 

 

Step 5 
saving the file                              Select File then Save As... 

 
 

A Save As window will open. Save the file in Photoshop format first, so you can make any changes to it in the 
future. 
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Then go to layer - flatten image and repeat the process (File>Save As...) and save it in the Photoshop PDF 

format. This is the file you’ll deliver to your printer. Click Save. 

 

A new Save Adobe PDF window will open. Make sure you select High Quality Print as a Pre-set. 
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 Content/topic 3 : Choose a bold and readable Font 
 

A banner or a header is a graphic that is found at the top of a web site which usually displays the company 

name and the logo. It is often the first thing a person sees when they open the website. The blending of 

colours should be attractive, informative, and comfortable for the eye and help to convince the viewer to 

stay on your site. 

Let's start with our banner. Here we have a general banner and the colours used are soothing to the eyes. It 

can be used for a fashion and beauty banner or a personal or holiday banner as well. 

  

 
 

  

  

 

Follow the below steps to create the above website banner:  

 

Step 1: Creating the banner size 

Open a new file by clicking on File>Open. Make the file size width of 780px and height of 120px. You can 

go till 140px for the height. You can make a banner flexible according to your design. 

Step 2: Giving the background colour  

Create a new layer. Name it bgcolour. Give a background colour by doing the following: 

 Change the foreground colour to #E4D1B8. 

 Click on the  Paint Bucket Tool seen in the tools panel on the right. 

 Click on the canvas with your mouse. Your background colour is now changed to the new colour. 

Step 3: Giving the inside background colour  

Create a new layer. Name it inside colour. Select  Rectangular Marquee Tool seen in the tools panel on 

the right. Make the rectangle size width of 760px and height of 100px inside the background. Fill it with 

colour # C64866 using the paint bucket tool. 

Step 4: Creating the logo background 

Create a new layer. Name it logobkg. Select Rectangular Marquee Tool. Make the rectangle size width of 

120px and height of 100px. Put the rectangle in the left side of the banner. Fill it with black colour # 

000000. 
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Step 5: Creating a logo using the custom shape tool  

Create a new layer. Name it logo. Choose the  custom shape tool seen in the tools panel on the right. 

Click on the Shape drop down menu seen on the top toolbar. Click on the arrow and 

select Ornaments. Look for the ornament which is in the banner.  

Drag it in the logo space and position it so it comes in the middle of the logo background. Now you have a 

temporary ornament as a logo which can be replaced with your company logo if needed. 

 

Step 6: Creating the vertical lines in the banner  

Create a new layer. Name it band. Select Rectangular Marquee Tool. Make the rectangle size width of 7px 

and height of 120px. Put the rectangle in the middle of the banner. Fill it with colour # E8B0BD. Make four 

copies of the layer band. 

To make a copy, right click on the layer and click on duplicate. A screen named Duplicate Layer will appear.  

 

 

Enter name of the layer as band copy. Click on OK. Do the same with band copy2, band copy3, and band 

copy4. Place the bands properly in the banner. 

Step 8: Creating the Logo Border  

Create a new layer. Name it border. Select Rectangular Marquee Tool. Make the rectangle size width of 20px 

and height of 100px. Fill it with colour # A63D56. Put the rectangle on the right of the logo background. Make 

a copy and place the new rectangle on the left of the logo background.  

 

Step 9: Creating the dashed lines now select the  Horizontal Type Tool (text tool). Type" _________" 

using the hyphen key. Place it on the top of the banner. Make a copy, right click on the layer and click on 

duplicate. Place it at the bottom of the banner.  

 

Step 10: Adding your Company Name with the text tool  type your company name or website name with 

the colour # FCF3E5. 
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LO 4.5 –Treat photo 
 Content/topic 1: Application of the exposure compensation 

Exposure compensation is used to alter exposure from the value selected by the camera, making 

photographs brighter or darker. In modes P, S, and A, the camera automatically adjusts settings for 

optimal exposure, but this may not always produce the exposure the photographer intended. 

 Identification of color correction techniques 

Color correction 

Color correction involves adjusting the colors to make them as accurate as possible. It's a crucial part 

of photo editing since your camera doesn't always capture the hues of a scene the way it should. If a blue 

sky turns up purple in your image, you'll need to make some adjustments to make it appear natural. 

Color correction helps by smoothing out the color from shot to shot and giving the video a more contiguous 

feel, allowing the viewer to focus on the story. 

 
 Application of the levels 

 
You use the Levels adjustment to correct the tonal range and color balance of an image by adjusting intensity 

levels of image shadows, midtones, and highlights. The Levels histogram is a visual guide for adjusting the 

image key tones. 

 levels 
Levels is a tool in Photoshop and other image editing programs which can move and stretch the 

brightness levels of an image histogram. It has the power to adjust brightness, contrast, and tonal range by 

specifying the location of complete black, complete white, and midtones in a histogram. 

 Application of the curves 
 

Curve allows you to manipulate the exposure, amount of light and tone of the image. In other words, 

depending on the curve you make, you can change and manipulate different parts of the image. When you 

drag the curve down it brings the exposure down. When you drag the curve up it brings the exposure up. 

Curves 
Curve is a remapping of image tonality, specified as a function from input level to output level, used as a way 

to emphasize colours or other elements in a picture. Curves can usually be applied to all channels together 

in an image, or to each channel individually. 

 Auto-tone 
 
Auto Tone defines the very lightest and darkest pixels of each of the three colors as white and black, 

respectively, and then arranges the midtones pixels in between. While it balances the tones in your image, 

the command watch for any introduction of a color cast. 

 midtones 
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Midtones these are neither shadows or highlights but rather a middle value of luminance. Shadows – Darker 

areas of the image that still maintain detail. Blacks – Completely 'burnt out' portions of a photo that contains 

absolutely no detail. 

 Application of the auto-tone 
Auto Color used to adjust the contrast and color of an image by searching the image to identify shadows, 

midtones, and highlights. By default, Auto Color neutralizes the midtones using a target color of RGB 128 

gray and clips the shadows and highlight pixels by 0.5%. 

LO 4.6 – export designed banner 
 
Content/topic 1: Saving banner design 
 

Step 1. Saving the file Select File then save as 

Step 2. A Save As window will open.  

Step 3. Save the file in Photoshop format first, so you can make any changes to it in the future.  

Step4. Then go to layer - flatten image and repeat the process (File>Save As...) and save it in 

the Photoshop PDF format. 

 Content/topic 2: The banners’ Sizes and names 

 
 
 

 

 

 

 

  

Size (Px) Name 

300×250 Medium Rectangle 

728×90 Leaderboard 

160×600 Wide Skyscraper 

300×600 Half Page 

970×250 Billboard 

336×280 Large Rectangle 

468×60 Banner 

234×60 Half Banner 

120×600 Skyscraper 

120×240 Vertical Banner 

300×1050 Portrait 

970×90 Large Leader board   

250×250 Square   

200×200 Small Square   

180×150 Small Rectangle   

125×125 Button   
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